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INTRODUCTION

This starting guide is a brief introduction to working with Advance Steel, describing the basic
methodology and not meant to replace formal training.

Advance Steel’s model based environment allows you to produce accurate detailed general
arrangement and shop drawings faster, helping to speed time to erection andfabrication.

The Advance Steel objects chapter describes the main objects to create a small steel structure.

Some of the Advance Steel connections are described in the Automatic Steel Connections chapter and
are used to create a small model. The 3D model is created using a 1:1 scale. The model contains
information about dimensions, objects, and attributes from which drawings are created as described in
the Drawing Creation chapter.

The examples presented in this guide are generic for worldwide use and do not conform to local or
specific company standards.

Since not all Advance Steel tools are described in this guide, refer to the Advance Steel Help for more
details on all commands and parameters.

Advance Steel

Advance Steel is a leading edge steel construction application designed for steel professionals. It
provides a simple user-friendly working environment for creating 3D structural models from which
drawings are created.

The three dimensional model is created and stored in a drawing (in DWG format). The Advance Steel
model forms the basis of the 3D construction. Complex structures are created using Advance Steel
structural elements (e.g., a stairway) with all the required features, joints, and connections, within a
command.

The Advance Steel model becomes the master reference for other tools:

e Dimensioned and labeled general arrangement and shop drawings are automatically created from
the model.

e The Advance Document Manager manages all general arrangement and shop drawings. The
update tool in the Document Manager makes single click drawing adjustments possible after
model changes.

e Structured BOMs (bills of materials) and NC-information are also created from the model and
include all model information such as part marks and quantities. The Document Manager also
controls these documents.

{\ AUTODESK. 4
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INTERFACES

All software tools described in this guide and all remarks related to the product pertain only to Advance

Steel and for reading simplification only the generic name Advance is used.

Where to find information?

Advance has a help system that offers step-by-step instructions for every function.

To access the help:

On the right side of the Advance Steel 2018 toolbar, click @ or use the F1 key on yourkeyboard.

INSTALLATION

System requirements

To successfully install Advance Steel, certain requirements have to be met.

For more details, see the Installation help.

Starting the installation

Before installing Advance Steel 2018:

- Make sure you have administrator rights.
- Close all active Windows applications.

- Disable the antivirus.

{\ AUTODESK.
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STARTING ADVANCE STEEL

To start Advance Steel:
- Double click on the Advance Steel icon on the desktop.
Or

- On the Windows task bar, click @, then select All programs = Autodesk = Advance Steel 2018
- Advance Steel 2018

ADVANCE STEEL USER INTERFACE

Advance Steel is fully integrated into AutoCAD®. Advance Steel panels are added to the AutoCAD®
ribbon.

@

FORRESALE Duwwingl o
T Wieg-me  Taaswred 7

| T mooel - L@ el s KL A M0+ 2@ F v.‘.E}—@

1. The Quick Access Toolbar
Provides fast access to the most frequently used tools. To add an Advance Steel tool to the
Quick Access Toolbar, right-click the ribbon button and select Add to Quick AccessToolbar.
The Quick Access Toolbar can be positioned above or below the ribbon.

2. Theribbon
Contains a collection of panels grouped on tabs, according to type. For easier access, the main
tools are located on the Home tab. On the panels, tools are grouped on different rows and
include large buttons for the most frequently used functionalities.

it =z

I

& ﬂ-ll & @ Connection

=2 [EE @ @) % vault
Structural Elements Joints
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Some panels can be expanded by clicking the arrow on the bottom line.
§3 Standard Grating
% Bar Grating

ﬁ Variable Grating, rectangular
§§ Standard Grating

% Bar Grating = Variable Grating, polygonal
E%g Variable Grating, rectangular 4 Grating at Polyline
X
Grating[=] {0 Grating

The ribbon can be minimized, thus enlarging the drawing area.

3. Tool palettes
Contain other tools, complementary to the functionalities available on the Advance Steel ribbon.

4. Command line
Allows Advance Steel commands to be entered using the keyboard. Press <Enter> after each

entry.

5. Status bar
It displays information regarding the program status during different phases of the project. It
also provides access to the configuration of certain parameters: snap modes, object tooltips
content, current coordinate system, and working units.

Other important tools for using Advance
e To cancel a command, press the Esc key.
e The current command and prompts are displayed in the command line window at the
bottom of the screen. Press the F2 key to open and close the command line window.
e The right mouse click behaves like the Enter key.
e When the cursor hovers over a ribbon button, the button's tooltip appears.
e The Undo command on the Quick access toolbar cancels one or severalcommands.

F . F

| Home Objects Extended Modeling
e The Match properties command copies properties from one object to another. The

transferred properties are selected from the given list.
limensicns  Export &Import Toels  Render  A360  Ad

r‘ b4 1._ 9 Il Bylayer -
= Byl =

Paste ID Match | b
M Properties| == ByLayer 1
Clipboard Properties = El

Advance Steel UCS

Advance Steel objects are created in 3D-space using the appropriate tools and their orientation is
dependent on the current User Coordinate System (UCS). To place the coordinate systems in the correct
position use the Advance Steel UCS tool palette.
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@4 =

A=

S0

Accessing Element Properties

When you create an Advance Steel element, a dialog appears, in which different settings and drawing

styles can be changed.

There are several ways to access the element properties:

=

=

5

=

il

e Onthe Tools tool palette, click

e Right-click the element and select Advance Properties from the contextmenu.

e Double click the element.

{\ AUTODESK.
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3D MODELING
Advance objects

Advance objects are created in 3D-space using various program tools. The object’s orientation depends
on the current UCS (User Coordinate System).

Creating a building grid

The grid is useful for placing construction elements and for orientation in the 3D view. Placing grid axes
is the first step of 3D modeling in Advance.

A building grid is created in the X/Y-plane of the current coordinate system and consists of two
independent axis groups: in the X- and Y- directions. The grid axis tools are grouped on the Grid panel of
the Objects tab.

Hi HH
o kHE
il a2

Grid

Example: Building grid with 4 axes in the X-direction and 3 axes in the Y-direction:

L,

1. Onthe ribbon, click H (Building Grid).

e Home - Objects 2 H (Building grid)
e Objects 2 Grid 2> Ht (Building grid)

2. Enter0, 0, 0 onthe command line to set the first point in the origin.
3. Enter 12000, 12000 to set the second point.

Next, modify the axes number in each group.

{\ AUTODESK. 9
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1. Select the X-axis group.
2. Right click and select Advance Properties from the context menu. The Axes parallel dialog box
appears. All modifications are made here.

To modify the number of axes:

1. Click the Group tab.
2. Set the Number to 3. Note that the distance value is automatically calculated. The new value in

the Distance definition should be 6000.

A Advance Steel - NOT FOR RESALE  Axes, parallel ==
Total
° Group index : 1
D D, D
Group Definition L —
Mumber 3
Single axis
Distance (D) : 600.0000
Display type

1 2 3 4 5 6

The model changes dynamically as values are entered or new values are selected, providing instant

visual feedback.

Repeat the same steps for the axes in the Y-direction, but setting the Number definition in the Group
tab to 4.

Creating columns
Columns are created directly in the model and are displayed, by default, in the Wireframe mode.

Columns are created as simple sections, compound sections, curved sections or welded sections. The
column creation is performed using the Column command on the Beams panel, Objects tab.

@ "'/g bE @ I Rolled I section -

Ed 8E conr I Welded bears, I Symmetic -

=1 3E & Beam  JJL Double channel - back to back -
Beams =

The command can also be found in the Objects panel, on the Home tab.
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Columns are simply placed in the model. You can place as many columns as you need. To exit the
command press the Esc or Enter keys or right-click your mouse.

Example: Creating HEA240 columns.

1. Onthe ribbon, select ﬁj
e Home - Objects 2> v

e Objects > Beams 2> A

2. Place the columns where you need in the model. In this example they are placed at the grid
intersections.

3. Right-click your mouse to exit the command.

The Beam dialog box appears. Select the section class (HEA DIN 1025-3), followed by the section
(HEA240).

{\ AUTODESK. 11
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Section & Material Section
Section [»]» HEADIN 10253 » HEA200 ~
Positioning
Unwind profile
MNaming
Fabrication data
User attributes
Display type
Behavior
Properties
Camber properties Material
Material » Steel » S235JRG2 -
Coating None i
Galvanizing
Construction dlass None
Detail dlass None
Confidence None

Creating beams
Beams are created directly in the model and are displayed, by default, in the Wireframe mode.

In Advance, a variety of different beam types are available. Beams are created as simple sections,
compound sections, curved sections or welded sections. The beam creation is performed using the tools
on the Beams panel, Objects tab.

@ @ FES @3 I Rolled I section ~

B ZE oy IL Welded beams, I symmetic -

= IEiE Beam  JJL Double channel - back to back ~
Beams =

The most used beam creation tools are grouped on the Objects panel, on the Home tab.

Straight beams

Example: Creating IPE300 straight beams from the top of one column to another.

{\ AUTODESK. 12
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1. Ontheribbon, seIectI.
e Home > Objects 2> I

e Objects 2 Beams 2> I
2. Select a Node snap point on the top of the firstcolumn.

Note: Make sure the Node option is checked in the Object Snap menu.

-~ Endpoint
/:/ Midpaoint
(2) Center
[=] Geometric Center
lv © Node |
€3 Quadrant

M .
o Intersection

—-— Extension

22 Insertion

_l_ Perpendicular

) Tangent

6 Nearest

\\ Apparent Intersection

. Parallel

FLANGE Middle

GRID Intersection Points
Prefered for Manual Dimensions

Object Snap Settings...

)E,Ia,kl:lvuv-

3. Move the mouse pointer to the second column top.

4. Repeat the same steps for as many beams as you want to create and then press Enter to exit the
command.
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Note: For a continuous beam creation, use the Continuous Beam command from the Objects tab, Beams
panel. Unlike the other beam creation commands, this one lets you select points continuously, not only
creating objects defined by two points, one by one.

The Beam dialog box appears. Select the section class (IPE DIN 1025-5), followed by the section
(IPE300).

Section & Material Section
Section » |Sections » IPEDIN 1025-5 » IPE300 -
Positioning
Unwind profile
Naming
Fabrication data
User attributes
Display type
Behavior
Camber properties
Material
Material b Stesl » S5235JRG2 -
Coating Mone e
Galvanizing
Construction dass Mone
Detal dass Mone
Confidence Mone

Automatic Steel Connections
Advance Steel helps you improve productivity by providing a parametric library of steel connections.

All individual joint elements, including their properties, are held together and represented as a gray box
connection object.

Note: A structural element creates several Advance objects at a time (i.e., entire structures are created
by simply clicking one button).

All parts of a structural element are related to each other and their height, position, section, etc., are
changed in one step.

Joints are available in the H | Connection Vault, which is accessible from the Extended Modeling panel
of the Home tab. The joints are grouped in categories according to the type of individualmembers.

Erzez B

Connection Advance Steel

vault £ [BE @ @ Tool Palette
Extended Modeling

{\ AUTODESK. 14
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[ Column - Beam @Y= AJ

[& Knee of frame bolted, with haunch

[% ¥nee of frame at web, with haunch

[j,:f’ Knee of frame with plate haunch and end plate

[iL Knee of frame at web with plate haunch and end plate

[lt Cross connection with haunch from a profile

[l l.}l; Knee of frame at web, with two haunches

[Q Column Beam Seat Angle

[E Column Beam Seat T

[ E: Seated beam connection

[E Beam Seat T

[ E Moment connection

[l Moment flange piates

[ l? Moment flange T

—
[F-:r Gable wall end plate

[t:,l:i Post double beam

[é’ﬁ Middle gable column

Selection order: 1. Column, 2. Beam
Profiles: Column = I section, Beam = I section, curved section

Description: A beam is connected to a column with 2 haunch that is created at the flange of a column. The connected beam is
adjusted. The haunch is created from a beam cut ar from plates.

Options: Various stiffeners, end plate, cap plate, additional plate, additional rafter, joint design

Frequently used joints can be grouped in the Favorites category for quicker access.

[ Favorites ) ¥ = }é]

[]E Clip zngle [j

Accessing joint properties

To access the joint properties dialog:

[ ] Double click on the connection object (the gray box).

[] Select a joint element, right-click and Select Advance Joint Properties from the context menu.

O Rotate

Draw Order
Group

Advance Properties

Advance Joint Properties
Show Assemnbly C5

Custom Connection Properties

Explode to ACIS

9% Add Selected
I} Select Similar
Tl Deselect Al

{\ AUTODESK.
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Creating a Clip Angle connection
The clip angle connects a beam to a column using an angle profile.

The tools for clip angle connections are grouped in the Column - Beam category of the Connection
Vault.

I

4] E —
[I Double side end plate with safety bolt
F’ vl
[ﬂ Platform plate
i

Example: Creating a clip angle connection.

( Platform beams @ ¥ =%
) [T comoe i
A T — ]
13 Ty—— ]
)
l

1. Onthe ribbon, click H ‘

(Connection Vault).

E.
Iz

Clip angle
2. From the Platform Beams category, cIick:IE pena

¢ Home = Extended Modeling 2 Connection Vault)

e Extended Modeling = Joints 2> (Connection Vault)

3. Select the column and right click.
4. Select the beam on which the clip angle should be created and rightclick.

The joint is created and the properties dialog appears. Modify the joint properties to suit specific
requirements.

{\ AUTODESK. 16
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A Advance Steel - NOT FOR RESALE Clip angle [3]
Im || Type Clip angle ']
Clip angle Mame:
Clip weld Upgrade to master
Top Cope r—!
= — |
Bottom Cope P | 'J_L
M- | T'=|
Bolt parameters —t qa | 5
d1 d2
Horizontal bolts ,17 I[:
Vertical Bolts M 'U[l l !
Slotted holes =
Shim Plates B

[¥] Automatic Approval status [ Mot Set - Mot calculated

Copying a connection
Any previously created joint can be used as a template and copied with all its properties.
Example: Copying a clip angle.

1. Select any object created by the clip angle connection to be used as atemplate.

2. Onthe Tools tool palette, click (Create by template).

3. Select the destination column and right click.
4. Select the corresponding rafter.

When a joint is copied, all its properties and logic relations are copied and the values for the joint are
only entered once.

Zoom/Shade

To better view the created connection, use the Zoom window tool.

Note: You can find this tool in the Navigation Bar on the right side of your workspace. If the Navigation
Bar is closed, you can open it, by going to the View tab = Viewport Tools panel and clicking on the
Navigation Bar button.

For a more realistic presentation of the model, use a shaded visual style. From the menus on the top-left
corner of the drawing area select Realistic.

{\ AUTODESK. 17
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Zoom Extents
v Zoom Window
Zoom Previous
Zoom Realtime
Zoom All
Zoom Dynamic
Zoom Scale
Zoom Center
Zoom Object
ZoomIn

Zoom Out

[=1[Custom View]|

1

Custem Visual Styles 3

2D Wireframe
Conceptual
Hidden

v Realistic
Shaded
Shaded with edges
Shades of Gray
Sketchy
Wireframe
K-ray

Visual Styles Manager...

To cancel the shading, return to the 2D Wireframe visual style.

Note: For a cleaner Realistic look, set the Visual Style to not show the Occluded Edges.

To do this:

1. Open the Visual Styles Manager, from the View tab.

. =
UCS | View | Navigation View
Icon | Cube Bar Manager

Viewport Tools + ;Viaw Manager |

E‘_‘% Mamed
S Join
Viewport ¢ =
Configuration @ Restore
Model Viewports

Select the Realistic visual style.
In the settings box, go to Occluded Edges and make sure that the Show setting isset to No.

{\ AUTODESK.

| | 2D Wireframe

Autodesk Advance 5

- 2D Wireframe >
] e

en  3DWireframe

Cﬁnceptual

Hidden

i i}
Shades of Gray

£ Gl
Sketchy Wireframe

Save as a Mew Visual Style ...

Visual Styles Manager...
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 VISUAL STYLES MANAGER

Available Visual Styles in Drawing
T ez

| Face Settings -
Face style Realistic
Lighting quality Smooth
Color Horral
Monochrome color 0 255,255,255
Opacity
Material display Off
[ Lighting =
Highlight intensity 20
Shadow display off

| Environment Settings -

Backgrounds off
| Edge Settings -
Show Facet Edges
alo W20 120120
Occluded Edges
o

@ - Occluded Edges on.
@ - Occluded Edges off.

Cancel Zoom

To view the whole object, use the Zoom Extents tool. The entire frame is displayed.

{\ AUTODESK. 19
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v Zoom Bxtents
Zoom Window
Zoom Previous
Zoom Realtime
Zoom All
Zoom Dynamic
Zoom Scale
Zoom Center
Zoom Object
ZoomIn

Zoom Out

Haunch connection

The haunch connects a column and a beam, using an end plate, welded to the beam and bolted to the
column.

The tools for creating haunch connections are grouped in the Column - Beam category of the
Connection Vault.

Column - Beam 8§ =3 ]

J—

? Knee of frame bolted, with haunch

ﬁ Knee of frame at web, with haunch

ﬂ Knee of frame with plate haunch and end plate

? Knee of frame at web with plate haunch and end plate

I; Cross connection with haunch from a profile

e = =l

| E Knee of frame at web, with two haunches

E Column Beam Seat Angle

[

[

[

[

[

[

~

[@ Column eam Seat
[CEE—
[

[

[

[

=

[

[

[

E Beam Seat T
i Moment connection

l@ Moment flange plates

X<

'? Moment flange T

F:.r Gable wall end plate

;I_l; Post double beam
% Middle gable column
ﬁ Pin-ended calumn

[N ) WS N | G GH—" ) — ) G | U S— L —" | | |SS— — ) s— L U—1 S—
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Example: Creating a haunch connection.
Go to the beams you need to connect.
1. On the Home tab, Extended Modeling panel, click H ‘
[w Knee of frame bolted, with haunch
2. From the Column - Beam category, select
3. Select the column and right click.
4, Select the beam and right click.
The connection is created and can be modified in the properties dialog box.
A Advance Steel - NOT FOR RESALE  Knee of frame bolted, with haunch [185] @
S Type Knee of frame bolted, with haunch ']
Properties Mame:
Library Upgrade to master
Joint design
General
Bolts & Welds
Stiffeners
[¥] Automatic Approval status [ Not Set - Not calculated

Creating a base plate

In this example, a base plate is created at the bottom of a column. The column is automatically

shortened by the thickness of the base plate.

The tools for base plate connections are grouped in the Plates at beam category of the Connection

Vault.
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Plates at beam @y = }(J

‘E—IEh Base plate

|E| Tube base plate

Corner base plate

[

E Base plate with traverse, bolted

J

J

J

J

) sose pste cut ]
J

J

J

J

Stiffener

Stiffener UCS

Stiffener box Column

I==

T I T T e T e e

fsss] Binding plates

X)[)T

Example: Creating a base plate.

1. On the Home tab, Extended Modeling panel, click H ‘

B Izt
2. From the Plates at beam category, seIect'th =
3. Select the column and right click.

The base plate is created at the end of the column and can be modified in the properties dialog box.
Both the column and the plate are welded together.

A Advance Steel - NOT FOR RESALE Base plate [539] (3m)
Base Plate Ancher type Geman J-Anchor s

Base patelay... * || Anchor srade -
Anchor assembly MNa'Wy -

Base plate dim...

Plate corners Invert anchor = /

Anchor and h... — Hole tolerance definition __:[2'
Tolerance value 30

\Washer plate
Create only hole ]

| ~ Hole diameter 230

<« [m 3

Stiffeners & Plates Slotted holes

]

Holes.

] Automatic Approval status [ Not Set +  Not calculated

{\ AUTODESK. 22



AUTODESK
. . ADVANCE STEEL
ADVANCE STEEL Starting Guide

Creating a bracing
You can create a bracing, using the Bracing command on the ribbon.

To access the Bracing command:

1. Go to the Extended Modeling tab - Structural Elements panel and click P (Bracing).

Note: Bracing creation is UCS dependent so make sure you set your UCS accordingly. Use t Move
UCS tool, from the Advance Steel Tools Palette = UCS category and set the UCS accordingly, to create
the view in the XY plane.

To set the UCS on the correct plane, use the UCS tools in the Advance Steel Tool Palette, UCS category:

f‘ s i
el
- I
" @ Rolled ° | Connection ~ ! % & # Advance Steel
7 = &~ @ Isection ™ ‘{; ot vault &5 EE @ @ Tool Palette
Draw = | Objects = | Extended Modeling

2. Create your bracing in the XY plane by selecting two diagonal points on the twocolumns.
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3. The bracing is placed and the properties dialog box appears, where you can make any required

modifications to your bracing.

[structural element Bracing

L

JL

A Advance Steel - NOT FOR RESALE Structural element - Bracing [617]
Properties Tyee
Type & Section Name:
Positioning Uparade to master
Geometry
Library
a1
Automatic Approval status [ Not Set

Now you’re ready to connect the bracing to the columns.

In this example, gusset plates at one diagonal will be created. The tools for connecting bracing members

using gusset plates are grouped in the General bracing category of the Connection Vault.

—

General bracings B ¥ = 4,\(]

"
9y

B Gusset plate to column and base plate

[? Gusset plate at one diagonal

?25 Gusset plate for 2 dizgeonals

DI

R Gusset plate for 3 dizgenals

Ll

|J@ Flat bracing with tension balt

]

IE Flat bracing with tension bolt and base plate

fil

-
H

[ Bracing I Splice Plates Single

2

P

~

{7_.

@ Bracing I Splice Plates Add Obj

% Bracing I Splice Plates Double

@ Bracing I Splice Angle Single

XL)¥)

@i Bracing I Splice Angle Add Obj

@g Bracing I Splice Angle Double

o J Ju Ju Je e Ju JU J _JL _JU L&)

[
[
[
[
[
[
(e
[
[
[
[
[
[

Example: Creating a Gusset plate at one diagonal connection.

1. On the Home tab, Extended Modeling panel, click H ‘

. 5/ Gusset plate at one dizgonal
2. From the General bracings category, select l? HesEL piste &t one disgens
3. Select the column to connect and right-click.

4. Select the bracing beam to connect and right-click.
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The connection is created and can be modified in the dialog box.

A Advance Steel - NOT FOR RESALE  Gusset plate at one diagonal [628] (3]
Pr tie:
SRErEEs Type [Gusset plate at one diagonal v]
Properties Hame:
Library Upgrade to master
Joint design —-TT
d2
|+ =
[
& 4
& || 4
Standard A#M
Additional connection
Stiffener & Cover
[¥] Automatic Approval status [ Not Set - Not calculated

Repeat the steps for the other 3 connections.

Inserting a hand-railing

The Hand-railing command on the ribbon easily creates a hand-railing along a beam, between selected
points. Simply select the beam and the points between which you want the railing to run and the hand-
railing is automatically created.

Example: Creating a hand-railing on a selected beam.

1. Onthe Home tab, Extended Modeling panel or on the Extended Modeling tab, Structural

Elements panel, click E (Hand-railing).
2. Select the beam and right click.
3. Select a start point and an endpoint for the railing and right click.
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A message will appear, asking you if you want to select a nosing point relative to the start point.

| Do you want to select a nosing point relative to the start point? |

| ves |

4. Select Yes or No:
e If you select No, the railing is automatically created and the properties dialog appears.
o If you select Yes, after you select the nosing point, the railing is automatically created and
the properties dialog appears.
5. Make the necessary settings in the dialog box.

A Advance Steel - NOT FOR RESALE Railing [3237] ==

el Type [Ralllng - ]

Properties Name:

Library Upgrade to master

Paosts.

Handrail

Post connection

Hang off rail

[¥] Automatic Approval status [ Not Set -

Inserting Straight stairs
You can easily create stairs; by using the stair creation commands (straight, spiral stairs or cage ladders)
on the ribbon.

Example: Creating a straight stair between two points.

1. On the Home tab, Extended Modeling panel or on the Extended Modeling tab, Structural

Elements panel, click 7 (Straight stair).
2. You will have three methods to define the stair size: Start and end point, Length and angle or
Height and angle. Choose the default Start and end point method by pressing Enter.

| Start and end point=0 (default), Length and angle=1, Height and angle=2 | (]

3. Select the start and end point of the stairs.
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-

4. Choose the stair alignment (left, middle, right).

[F]

5. The stair is created and properties dialog box appears, where you can make the necessary
settings.

A Advance Steel - NOT FOR RESALE  Stair [324] =
Properties

Properties

Type

Name:

Library Upgrade to master

Distances + Stringer

Step - General

b

ibhl

Approval status [ Not Set

Step -Top.

2

a

Step - Bottom

Landings

Inserting isolated footing

Example: Creating an isolated footing under a column base plate.

To insert an isolated footing:

1. Go to the Objects tab > Other objects panel and click ./ (Isolatedfooting).

2. Specify the position of the footing or select a snap point to define its position under the base
plate.
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3. Theisolated footing is created and the properties dialog box appears, where you can make
the necessary settings.

A Advance Steel - NOT FOR RESALE Isolated Footing [3429] =)

Shape &Material Shape [HM v]

Positioning Length 800.0
Width 800.0
Naming

Height 600.0
User attributes
Materizl b Comcrete » C20/25 h
Display type

Behavior

Clash check

A clash check tests if there are model interferences. Object interferences might be due to various
modifications made to plates, bolts, members and their connections. This tool finds all interference
cases so that they are fixed in the model before drawing creation.

The Advance Clash Check function checks selected elements or the entire model. Interferences are
displayed as red collision solids and listed in a text window.

Example: Checking the created frame for interferences

1. Onthe Home tab = Checking panel, click i (Clash check).

% &

=i
Model 72 18
Check & [EB

Checking =

The Clash check dialog box appears containing the list of all collisions. If there are no collisions, the
notification line displays “Collision check found no errors.”

2. Close the window.
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NUMBERING

The Advance numbering tool automatically numbers Single Parts and Assemblies for the entire model.
The numbering finds identical parts that should have the same number.

The numbering procedure is a single button function and works on the entire model or on selected
elements.

With automatic numbering all beams and plates obtain a single part mark. All other elements are
classified as attached parts. The numbering for single parts and assembly parts is done in one step or
separately. The numbering tools are grouped on the Part marks panel of the Output tab.

) T Re | 9nd
: Buomn Bt [a
= (g |EE|v =
i E 3n3
. r‘:: =r
Numbering g E
] — 12 .
= 272 3 = I
Part marks

Example: Numbering single parts and assemblies in one step.

1000

1. Onthe ribbon, click (Numbering).

e Home tab - Documents panel, click

1000

e Output tab > Part marks panel, click

2. Inthe Numbering dialog select Process single parts and define the: Start value, Increment value,
and Method of numbering.
3. Select Process assemblies and define the Method of numbering.

A Mumbering - Identical part detection @
General |Specia\ I Standard Part Template
Post number method lNone V]

Preliminary mark

Process Preliminary mark
Start 1
Increment 1

Single part

[¥]frocess single partst
Start 1000
Increment 1
Method SP: 1000,1001...MP:123 V]
7] Add zeros |2
Format %Prefoc’ MethodNumber

Assembly

Process assemblies
Start 1000
Increment 1
Method (sP: 1000.1001..MP:1.2.3 -
| [Add zeros |2
Format %Prefix:MethodNumber
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DRAWING CREATION

The 2D drawings are obtained after the design and numbering of the 3D model.

Advance Steel offers a variety of drawing styles for the creation of general arrangement drawings,
sections, and shop drawings in various designs.

A drawing style is a group of instructions used to create a detail drawing. It defines how the elements
are displayed, labeled and dimensioned.

Drawing styles automatically create drawings with a layout configured exactly to the user's
requirements. Drawing styles are used similarly to AutoCAD's dimension styles, line styles etc.

The styles contain various settings (displayed parts, view, dimension, labeling, representation, etc.) in

database tables (libraries). Styles are available in the Drawing Styles Manager @) - Output tab
- Document Manager panel.

The preferred selection of the existing drawing styles, are displayed in the Drawing Style Palette.

(1-GA3DView @@ ¥ = ¥

@

Camera V - MoDim Molab

Wiew W - MoDim.., ]

Wiew V - NeDim Molab

{\-'Zew W - NeDim Mg PesSmGuid

View V - Sel.Parts MoDim.. ]

3D-View UCS without hidden lines - without dimensioning - without label
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The rules included in a drawing style can be modified. You can also define your own drawing styles.
The drawing style distinguishes between single parts and assemblies and it is used for drawing creation.
The tools for creating drawings are grouped in Quick documents Palettes
There are three Quick Documents palettes:

1. The Drawing Styles palette

2. The Drawing Processes palette

3. The BOM Templates palette

The palettes allow you to quickly browse and use drawing styles and drawing processes for drawing

creations as well as list templates for BOM list creations. The categories are represented by intuitive
images.

Drawing Styles palette

2 - GA Detail View OB =%

1)
et

Camera Detail ¥ - NeDim MpSp PosSmGuid

Detail VH - NoDim MpSp MamePosSmGuid
n
Detail VH - Sel.Parts NoDim MpSp NamePossmGuid p-a ™ sy

2 L1ULEI0 |ll/- 1
. IPE240 [EE],

L7 B0 e o

1 aaxE [70]
s

D

Detail VH - NoDim Molab

i

| qJ
[ )
[Detail VH - NoDim MpSp PosSmGuid ]
[ )
[ )

N

Q)

s IHE TBE]
PG lﬁli

MNade detail UCS Digi visible and hidden lines - without dimensioning - main
and single parts labeled with position number and section name or resp, plate
thickness
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Drawing Processes palette

Assemblies - Selected @ig ¥ = M]

10 18 23g 15
womT T
10an

Selected Assembly - AutocPage

]
REE oL
T
|
1
|
1
|
{
|
L
|
i
l
E =
afy
.
P/

Selected Assembly Each A3

S
|cI
=
S P
I
=
=
B

Selected Assemily PageFull AD | i A-A
Selected Assembly PageFull A2
ApPas 1000 +A
w Iﬂ%

Selected Assembly Plate Each A3 |

;
e e e 'lZ.'G Py - T (|
#
w01, i f m:! !
=1

4
—t—,

" 1

pa
b+
ke
ke

dgp

Selected Assembly Plate Each A4

Selected Assembly Plate PageFull A2

|
|
|
|
|
|

BOM Templates palette

- ] 4
[ Assembly List @@t = X]
Iqjl
Assemblies with attached parts list
ig P J A e Company
ACANCE STEEL - e -
- Prspec:
- Assembly list ASZEMELES WITHATT.  Deie: Can otFaitd
PARTS
T G T T T CE=—ren
e -
[Assembly list - bolts ] Aepen Al prapen
a4 C1I0NES £ ey A w 1
a4 mom e avan | wer 1w
[Assembly list - exploded bolts ] s 4 mnan 0wl v
a4 mm B WA R4
a4 Gliezs woo mer  armi e
Compound beam list s 4 RODI0 W WM e
AW 1 CAZORES RIS L e NI
a4 uamm: e ey T v e
Loading List
st ] o R —
a4z s aTr o war e iz
i i CAZORES P Y A n [
w3 ctmzs sein st wews s

Example: Creating an isometric view.
Save the model prior to starting the drawing creation.

The viewport of the created view depends on the active user coordinate system (UCS). The view
direction is against the Z-direction of the UCS.
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1. To create an isometric view, click on the UCS tool palette and place the UCS in the plane of the
screen.

( ucs @Y =%

Drawing

2. On the Output tab, Documents panel, click swie,

3. The Drawing Styles tool palette appears. In the 2 — GA 3D View category, choose one view type
(e.g. 1 - GA 3D View — 2.2 3D View — Model — w\o Labels).
([ 2-cADView OB =%

)

- 3D View - Model - w/ Labels

[2.2 - 3D View - Model - w/o Labels

~
- 3D View - Railings/Ladders - w/ Labels ]

- 3D View - Purlins/Girts (cold rolled) -...

- 3D View - Claddings - w/ Labels

4. The Create detail dialog box appears. From this dialog you can choose between two options to
create the detail.
Create detail @

Create detail with...

2 Create with default settings
Drawing name: 4.dwg
Prototype: ASDETPROTO-ANSI-E.DWG
Scale:

2 Modify settings

Cancel

5. Choose Modify settings.

6. Inthe Select destination file dialog 2 New drawingtab:
a. Name your drawing: e.g. Isometric view.
b. Change the scale to 1:20.
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c. Seta path for a separate DWG in which the detail is placed.

[ Switch off level symbols

[ Switch off weld symbals

[ Switch off building axes/grids
[ Switch off hidden lines

A Select destination file Lo (O]
New drawing | Detail bowx I Prototype template) | Existing drawings |
Drawing number |sometric view
File name ChProgramData\Autodesk \Advance Steel
Scale 1:20 M

[ Switch off clipping
[ Switch off hole representation
|
[ ok | [ caead | [ Hep

7. Inthe Select destination file dialog = Prototype template tab, select the prototype template:

A Select destination file

Frotctpe (ompll) | Busting s

Lo o5

= Shared
ASDETPROTO .dwg
ASDETPROTO-AD.dwg
ASDETPROTO-AT.dwg
ASDETPROTO-AZ dwg
ASDETPROTO-A3.dwg
ASDETPROTO-A4-PORTRAIT dwg
ASDETPROTO-ANSI-A.dwg
ASDETPROTO-ANSI-A-PORTRAIT dwg
ASDETPROTO-ANSI-B.dwg
ASDETPROTO-ANSIC.dwg
ASDETPROTO-ANSI-D .dwg
ASDETPROTO-ANSI-E.dwg

»

m

8. Click OK to close the dialog box.

The drawing is created and saved as .dwg in the specified path:
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@@'| 1) C\ProgramData\Autodesk\Advance Steel 2018\Worl] - |

Organize « Include in library = Share with « New folder

-~

. Favorites TR

Isometric view.dwg
B Desktop Isometric view.dw!

Isometric view.dwl2

4 | Isometric view.upd

Example: Creating an Anchor plan view.
Save the model prior to starting the drawing creation.
The viewport of the created view depends on the active user coordinate system (UCS).

1. The view will be created in the XY plane. Set the UCS to correspond to the view direction, like in
the image below:
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=

Drawin
2. Go to the Output tab, Documents panel, click Styles

3. The Drawing Styles tool palette appears. In the 3 — GA Plans/Elevation/Detail category, choose

the view type (e.g. 3.1 — Anchor plan).
[ 3 - GA Plan/Elevation/Detail ({&} ¥ = X]

ﬂ"?. >
[3.1 - Anchor plan ]/

3.2 - Plan

3.3 - Elevation

34 - Plan/Elevation detail view - pickbox

N

3.6 - Plan - Railings/Ladders

3.7 - Plan - Gratings

3.8 - Plan/Elevation - Purlins/Girts (cold rolled)

[
J [
[
[
[
E
E

(N W U W— W W— L W— W—

- Plan/Elevation - Claddings

4. The Create detail dialog box appears. From this dialog you can choose between two options to
create the detail.
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Create detail [
Create detail with...

2 Create with default settings
Drawing name: 4.dwg
Prototype: ASDETPROTO-ANSI-E.DWG
Scales

2 Modify settings

Cancel

5. Choose Modify settings.
6. Inthe Select destination file dialog 2 New drawingtab:
a. Name your drawing: e.g. Isometric view.
b. Change the scale to 1:20.
c. Set a path for a separate DWG in which the detail is placed.
7. Inthe Select destination file dialog = Prototype template tab, select the prototype template:
8. Click OK to close the dialog box.
The drawing is created and saved as .dwg in the specified path:

a> az ) a

H20x560 H20 %360 H 20360 M2 561

H20x560 H20 %360

H 202360

M2 560

|
|
|
|
|
|

_V -
=
H B 250 @%

H 202360

A - _—- - —_————— >
[1i13] Lri ] | AP
12 i) <) @
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Example: Creating an Elevation view.
Save the model prior to starting the drawing creation.
The viewport of the created view depends on the active user coordinate system (UCS).

1. The view will be created in the XY plane. Set the UCS to correspond to the view direction, like in
the image below:

=

Drawing

2. Go to the Output tab, Documents panel, click st

3. The Drawing Styles tool palette appears. In the 3 — GA Plans/Elevation/Detail category, choose
the view type (e.g. 3.3 — Elevation).
[ 3 - GA Plan/Elevation/Detail @&} ¥ = XJ

- Plan

3.3 - Elevation

34 - Plan/Elevation detail view - pickbox

3.5 - Detail connection - pickbox

3.6 - Plan - Railings/Ladders

3.8 - Plan/Elevation - Purlins/Girts (cold rolled)

3.9 - Plan/Elevation - Claddings

(N W W NI W— S— g W L

[
[
[
[
[
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4.

@

The Create detail dialog box appears. From this dialog you can choose between two options to
create the detail.

Create detail [

Create detail with...

2 Create with default settings
Drawing name: 4.dwg
Prototype: ASDETPROTO-ANSI-E.DWG
Scales

2 Modify settings

Cancel

Choose Modify settings.
In the Select destination file dialog 2 New drawingtab:
a. Name your drawing: e.g. Isometric view.
b. Change the scale to 1:20.
c. Set a path for a separate DWG in which the detail is placed.
In the Select destination file dialog = Prototype template tab, select the prototype template:
Click OK to close the dialog box.
The drawing is created and saved as .dwg in the specified path:

IPE300 PE300

i

HEA300
@
HE A300

I 11 |
M20x560 4000 4000 20x560
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Drawing management

The Document Manager is used to preview, manage and erase the created details in separate drawings

(DWGs).

The link between the model and the drawing is managed automatically. Advance automatically detects
the details that require updating due to model modifications. The Document Manager also controls

drawing updates.

The Document Manager controls all dependent details and lists all information (e.g., which model

drawings have been created and how many). More than one detail can be stored in a single DWG. The

Document Manager tree structure shows the details that are in each DWG.

Opening the Document Manager

ocument

D
e On the Home tab, Documents panel, click msnsaer

=
Document

e  On the Output tab, Documents panel, click manage

A Docurnent Manager o =)=
=B Project documents Properties | Preview | Force update
- fBH Details
Eof Uptodate St maaad
(-(_-[B8 Anchor Plan.dwa
EO— ﬁ-‘; Isometric View.dwg
Lists
== Dsty-file 1 Not Set
Add to batch plot
Add to explode
Change prototype
Open drawing
Automatic detail
status check

Warning: If this option
is not selected, then
the drawing status is
Status check [ OK ] [ Cancel ] [ Help ] not correctly shown
unless a "Status cherk”

The Document Manager lists all the created drawings, bill of materials / structured BOMs and the NC-

data created from the model. The documents are displayed on the Preview tab.

Create Shop Drawings
Example: Creating a single part plate drawing using a drawing style.

To create a single part detail drawing:

Drawing

1. On the Output tab, Documents panel, click st
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2. The Drawing Styles tool palette appears. In the 6 — Singleparts category, choose one view type
(e.g. 6.11 Sp — Plate).

6 - Singleparts @iy = XJ

%,ﬁ

6.01 - Sp Beam

6.02 - Sp Angle

6.04 - Sp Girt and Purlin

6.07 - Sp Curved beam

[
[
S
[
[

=7

6.08 - Sp Polybeam

[E 10 - Sp Plate

6.12 - Sp Folded beam/plate

[E‘ll - 5p Grating

3. Select the plate from the 3D model and right-click.

4. The Create detail dialog box appears. From this dialog you can choose between two options to
create the detail.
Create detail =2

Create detail with...

2 Create with default settings
Drawing name: 4.dwg
Prototype: ASDI:TPROTO ANSI-E.DWG
Scale:

2 Modify settings

Cancel

5. Choose Modify settings.
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6. Inthe Select destination file dialog 2 New drawingtab:
a. Name your drawing: e.g. Isometric view.
b. Change the scale to 1:20.
c. Set a path for a separate DWG in which the detail is placed.
7. Inthe Select destination file dialog = Prototype template tab, select the prototype template:
8. Click OK to close the dialog box.
The detail drawing is created and saved as a .dwg file in the specified location. You can either
open it from the specified location, from the Document manager or by right-clicking on the
model object and selecting Show part detail.

v Document Manager
ik g

=B Project documents Properties | Preview Force update

[BR Details

E‘( Up to date & S‘ﬁ O\i ® 588 Update Revision
({8

J 1
i
4

Revision

Delete

87 114 [ Mot Set -

52
2014 1129 Add to batch plot
—

Add to explode

123 63
| 126 |
— W

|

58 [ 100

| s |

Change prototype

Open drawing

Automatic detail
status check

Warning: If this option

is not selected, then
the drawing status is

] not correctly shown

unless a "Stahus check”

Status check [ QK ] [ Cancel ] [ Help

Repeat ASTORDOCCHECK

Recent Input »
Clipboard »
Isclate 2
Erase

Move

Copy Selection

Scale

Rotate

Draw Order »
Group 3

Advance Properties
Advance Joint Properties
Show Assembly CS

Custom Connection Properties
Show part detail

Explode to ACIS

Add Selected

Select Similar
Deselect All
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Example: Create a shop drawing with all the plates that are single parts, using a drawing process.

To do this:

R

Drawing

1. On the Output tab, Documents panel, click Processes
2. The Drawing Processes tool palette appears. In the 4 - Singleparts - All category, choose one
view type (e.g. 03- All Singleparts A2 - Fill the sheet).
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4 - Singleparts - All

@& Y = ¢

u 2 All Singleparts

- Al - Fill the sheet
- All 3ingleparts - A2 - Fill the sheet
- All Singleparts - A3 - Fill the sheet

- All Singleparts

- Al - One per sheet

- A2 - One per sheet

- All Singleparts

- A3 - One per sheet

- All Singleparts

- A2 to AD - Fill the sheet

2 - All Singleparts

[
[
[
g
:

- Adto AZ -

One per sheet

j
)
)
)
)
)
)
)

3. Inthe Process properties dialog, from the Selection drop-down, choose All SpPlate and click OK.

Process properties

Selection

All Sp Plate

Drawing number

Drawing number

Drawing number increment

4
1

Amangement by posttion, ascending

Select existing drawings to uss forthe detailing procsss:

o o |

Help

]

FIE)

4. The detail drawing is created and saved as a .dwg file in the Details folder; in the same location
your model is saved. You can either open it from that location, from the Document manager or
by right-clicking on any of the detailed model objects (in this case, on any plate) and select Show

part detail.
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Repeat ASTORDOCCHECK
Recent Input »

Clipboard r

Isolate r

3, Copy Selection

Scale

() Rotate

Draw Order »

Group 3

Advance Properties
Advance Joint Properties
Show Assembly CS

Custom Connection Properties

I Show part detail |

Explode te ACIS

©3  Add Selected

A Document Manager

By Up to date

- Lists
[ psty-file

Properties | Preview

I?I@

|

Force update

ggaeaaaq

Update Revision

Revision

Delete
[ Mot set -
Add to batch plot
Add to explode

Change prototype

Open drawing

Automatic detail
status check

=

Warning: If this option

is not selected, then

Help

the drawing status is
] not correctly shown

unless & "Statis cherk™
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Note: If an object is detailed on more than one drawing, you will have more options to choose from in
the Show part detail contextual menu:

Repeat ASTM4COMMDETAILPROCESS
Recent Input

Clipboard
Isolate

Erase
+3+  Move

Copy Selection

Scale
Rotate
Draw Order
Group

Advance Properties

Advance Joint Properties

Show Assembly CS

Customn Connection Properties
Show part detail r| 001
Explode to ACIS 003_A2-Plate

% Add Selected

Select Similar
Deselect All
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LIST CREATION

To quickly create a Bill of Material list you need to access the preferred BOM templates, using the Quick
Documents - Bill of Material template.

1. You can open the Quick Documents BOM template palette from the Outputtab

=
BOM
- Documents panel = Temia=

2. To create a list, click on any of the available templates.

Note: You can also preselect objects in the model, and the BoM template list will be created only for the
objects in the selection.

A Deam list =&
& Open [l 5ove T Bpont
[ dbpwe (B (B 25 B % - 1"
| 1 5 O ' B =
| AUTODESK: Compa_ny.
| ADVANCE STEEL Extract DietaifagEatadami
Client dob:
Project
BEAM LIST Detailer Date 28.Jan. 2016
Mark Tiame Tuantly  Gualily Tenglh  Wmghl  Weeght ol Gurlace Tolal  Descophion
imm}  per mater of piece weight of piece Surface
(Kgim)  (Kg'peece] (Kg) (m2ipisca) (m2)
0 PEND 1 AR 3,968 42z 1675 %78 45 48
21 PEIY 1 Al 3973 422 1677 677 461 461
4 PEI0 2 Amg 5670 422 2393 4T85 658 1115
1000 LEOKS & Asm =20 97 21 28 ot 041
1002 L120X80X10 P A 2 15 33 66 (1] 017
12 a1 2295
12 Lkx] 293 _—
|
“ | ﬂ
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Once the list is created, it will be opened in the BOM Viewer and can be saved and registered to the
model.
To add or remove BOM templates from the User category of BOM templates - Quick Documents palette,

you need to set the status of the checkbox associated to the BOM template list in the E? (BOM Editor)
(Output tab = Document Manager tab).

Note: Change palette content category - Advance / User / Country: You can switch between categories
by clicking the first icon on the palette title bar - the content of the palette will change depending on the

chosen category:

[ Drawing s‘tyle b }\{]

The icons differ for each category:
Drawing styles @&} ¥ ¢ }S]
Drawing styles £ {3} ¥ & ?,&]
:Drawing styles ED{S) ¥ }é

A Template deor s — = =
[ Part lists G- ),‘i] e Edt [ Part lists LE Y =¥
] ; | & & B, 0% - 3
(2 |artcen ] AT
| ek Topii
o Tk
ST
2 1 E Asvernbly et
e 53 10 Fastener st
. 5 [ Fanies ] T
@ r -0 B0 of Mol Metnc)
e 2
- L
Egme«vm summany " o s
47 i Grating it
IS Frosimmary bt s | v
[ S b e
i Saw ket pactures ny Matoriai dst
bt ChutCorbal |
5 Fepotnia o = =
I CoomsSecmnine ShowPaami Tns T
J £} CiosiSectonBon o &[] foce 3
E— prrarl Er
; . sk =4
e
statusLabel2

Example: Create a Material List.

1. Output tab - Documents panel > Tempes

2. The BOM Templates palette appears.
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Part list @it = X]

Beam list

Balt list

Grating Iist

List with curved beams

{
{
{
{
{
{

List with exploded bolts

[Ma:er'el ist

Material list summary

Plate list

Saw list Picture

Shear stud list

(N W ) W N S S W L W ) W W W ) S W

{
{
{Sa'.\' list
{
{

3. From the Part List category, select Material List.
The Material List appears. It can be printed, saved, exported to PDF (and other formats) or sent
by e-mail using the corresponding icons on the menu bar.

A Material list o= )
= Open [ Save [ Export
[ |gEhpint... |5 |3 - B 18 Backward (%) Foward | ¥~
e 1 3 | 4 5 B | 7 £ 3 [N N 1 (=]
: AUTODESK: Company:
- ADVANCE STEEL Extract DetailDwgExtracteml
I Client Job:
- Project
! ‘ MATERIAL LIST ‘ Detailer Date  31-Mar-2016
z Mark MName Quantity  Quality Length Weight Total Surface Total Description
R (mm) of piece weight of piece Surface
- (Kg/piece) (Kg) (m2/piece) (m2)
2
T Beams
B 1 IPE300 6 A992 3,969 167.5 1.004.9 4.604 27.623
3
. 2 IPE300 5 A992 5,670 2393 1.196.4 6.577 32.886 =
; 3 HEA300 3 A992 2,980 263.1 7894 5.126 15.377
Z 4 IPE300 3 A%92 3,973 167.7 503 4.609 13.826
5 5 HEA300 2 AZ92 4,980 439.7 879.5 8.566 17131
4 | » H

4. Click Export. The Report export dialog appears displaying the exportoptions.
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5. Select an export format from the list.

6. Click OK.

7. Save the created BOM file. A file name is requested in a new window. The BOM file is saved as a
Report in the ...\[model folder]\[model name]\BOM\[BOMfilename]folder.

CNC DATA CREATION

Advance Steel produces CNC files (DSTV format) for workshop machinery directly from the 3D model.
You can either select one model object or the entire model to create these types of files.

You can access the commands for the CNC data creation from:

e The Output tab > NC&DXF panel
e The Home tab 2 Documents panel

= = HC|
- Ei 7 " m
= Cﬁ 52 CaM
Mumbering Document * Create Cﬁ -

manager [ lists | |Pd M &

Documents NC&DXF =

Example: Create an NC file for a selected model object.

1. Select a model object.

2. Goto:
e The Output tab > NC&DXF panel and click

e The Home tab & Documents panel and click
3. The NCfile is created and is saved in the DSTV folder that is automatically created in the same
location as you model DWG.
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|Command: |
Command: AstMACommCreateNCByStyle 1
The WC files hawve been created successfulls

G-

‘W C:'\ProgramData\Autodesk\Projects\Industrial Examp

Organize * | | Open MNew folder
3 2 MName : Date modified
[ Favorites
|| C1007.nc 8/6/2015 6:19 PM
Bl Desktop | C1007.upd 8/6/2015 6:19 PM

You can also access the NC files, using the Document Manager, where you can see a preview of the file.

r M
. Document Manager i |n(S
1= B2 Project documents Properties | Freview Force update
BH Details I
th 5] Lists ST = Update Revisior
=2 Dstv-fie z
-] DStv-List o001
=~ pstr-nc 1021
-+ Up todate 1021
[ c1007.nc 2992 =
HEA300
|
2980.00
290.00 B
J00.00
14.00
.50 Change pr
27.00
88.30 Open draw
1.72
0.00 Automatic detail
0.00 status check
0.00 Warning: If this option
0.00 is not selected, then
the drawing status is
not correctly shown
o urless a "Status check”
Sta [ oK J [ oo ] [ Help Is done
%

This small exercise was a very simple introduction to Advance Steel. In time, your familiarity, speed, and
understanding of the power and versatility of Advance Steel will improve, as you use the software on
real projects.

RECOMMENDED PRACTICES

Saving the project

1. Create a folder structure to store your projects in correctly, create a projects folder and then
create sub folders for each project.

In that folder store the model which then creates its own relative folder and required sub
folders. This keeps all models and databases separate and avoids conflicts.

2. Create an AutoSave folder location and adjust your system to save your automatic backup files
to that known location, keep it simple and at the root of the System such as
C:\AdvanceSteel\Autosave.

3. Save your model at regular intervals.
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4. Use a suitable Name for the Model such as the contract number, project reference or place

name. This can be useful later on in the project, as the model name can be listed in the drawing

and NC naming and also be linked to the actual file references.

Modeling

5. Always start your model at 0, 0, 0 in the World Coordinates.

6. Be aware of how you model a beam/section “Right to left” or “left to right”, as this can influence

how the front and the back of beam are displayed on an assembly drawing.

7. Columns — Always try to model so the Z Axis of the column flange is to the outside face of the

building for perimeter columns.

8. System-line placement — When modeling horizontal members, roof members, floor beams, etc.

always try to have the system line in the top of the profile at the middle of the flange. This

affects the assembly drawing dimensioning.

For Columns try to keep it in the center, unless you have a specific need for one column flange

face to be at a set location, as this means that if you change section then the change in size goes

away from that face. So the flanges still remain in line. This is sometimes used where cladding is

applied directly to hot rolled steel flanges.

For purlins and rails, try to keep the system line to the bottom face nearest the supporting

beam, as then if the size changes for the rail, the difference goes outwards, rather than altering

the hot rolled frame set-out.

Always try to make sure your system lines meet for beams columns, etc. This is like you wire-line

in the model and with this it is easy to check the primary position of an object, also the system

line is used as the datum for the dimensioning of the Drawings and in other aspects of the

modeling.

9. Remember your UCS; this is a vital tool in placement and orientation of objects within the

Advance Steel environment.

10. For complex setting out of a building, say radial, always try to have some reference/construction

line geometry in the system, create a layer and place it in there, it can be turned off, but it is

always there for reference.

11. Before you model a beam type, like poly-beam, or curved beam, consider how you are going to

manufacture it and more importantly how you are going to detail it.

>
>

For simple curves use curved beams, rather than poly beams

For complex beams, that may appear too easy to create as poly beams, look at how the
original shape line is created. If it is from a series of curves of known radii, model it as a
series of curved beams as you will buy it as curves and then weld or joint together. Poly-
beams do not lend themselves to being dimensioned as radii; they work on points based
upon the references they were created from.

KEEP IT SIMPLE — SIMPLE TO MODEL = SIMPLE TO MAKE.

12. Note the difference between holes and contours, make a decision on how the hole will be

produced, drilled or cut out via cutting torch or profiler. This affects drawings and NC
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Processing. For drilled holes use the Hole commands. For profiled holes use the Contour
commands. The size of the hole makes no difference to how the NC describes it.

13. Assess your project before you start, look at how you are going to build the structure, how it is
going to be delivered, where you are starting from, craneage, etc. You can model it in Advance
Steel, but you are the one driving it, it goes where you steerit.

14. Try to use Macros where possible for Joints. When using macros, if you create a joint and think
you may use it again somewhere, store it in the table with a suitable reference. For example
bracings, you can set one up for Flats and one for Tubes, save each to the table and then when
inputting bracing you can just select that default.

15. Use the Project Explorer to manage the model structure, set up views so it’s easier to work on
plan or elevation at a time.

16. Always use model roles, as this defines the prefix in numbering and also has influence with the
drawing output. The drawing styles link to the Model roles to set the style within the process.

Numbering

17. Use the standard numbering rules set in Advance Steel and try to work with those, always let
the program to update the model numbering, DO NOT MANUALLY NUMBER UNLESS YOU HAVE
TO, this can lead to problems.

18. If the model is not complete, then try numbering using the Lot/Phase option with the box
checked. This means that the existing part of the model will have unique numbers. These
numbers will not be used elsewhere in the model in later phases. This means you can carry on
modeling and then just renumber at a later stage and numbers / items from phase 1 will not
alter their numbers.

19. Use the preliminary numbering of the model; adjust the BOM lists to include preliminary
numbers. These references never change and can be a good way to track items whose final
number has changed. For example, if you pre order curved beams, this reference can be used to
track that component.

Creating drawings
20. GA Drawings

Think about what you want before you start; map out how you are going to approach the
drawings. For example, floor plans first in level order, from ground up, then Elevations going
around the building, Sections through the building, local details of special joints / typical joints,
3D Views of model. Lot phasing 3D views.

Plan it on a piece of paper, make a list, assign the drawing numbers for GAs to follow this
pattern, so you may have 5 drawings for plans, 4 for sections, etc.

Think about the SCALE on the paper, if you can combine two elevations onto one drawing, etc.

21. Part Drawings
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Think about how they are going to be manufactured — in house, sub contracted off profilers, etc.
All ordered in at once or in phases. This may change the paper size you choose to produce the
drawing on. A3 or A4 single item puts each part on its own drawing, makes it easy to send, each
drawing is relative to each part and that part only.

22. Assembly Drawings

Think about how they are going to be fabricated — all in one shop, subcontracted to various
workshops, in phases, etc. Sometimes it is easier to create single drawings for each assembly, as
they can be fitted onto smaller A3 size, most small fabricators only have limited printing
facilities, and so sending Al drawings can mean that they print at a vastly reduced size leading
to mistakes, omissions or lots of phone calls to clarify what something is. So set up to smaller
sheet to start with a larger scale to show the detailsclearer.

23. Check the drawings — sometimes things get missed or mixed up in the model, and are not always
picked up. Use the drawings to check what is being produced. A quick review can save you time
and money in the long run.

Lists

24. Filter the model to produce lists for required items; use the lists that are set for Curved Beams,
plates, beams. Use the list to check the model and that you have done all the drawings and
things are not missed.

NC files

25. If you want only plates of a certain size then use the search filter to find and select them, then
create the NC files. You can adjust the naming of the files and details shown on the hard stamp
to include things like thickness, number, using the defaults.

26. Be aware of the Defaults in the Management Tools application; there are many settings there
that can be adjusted to change the outcome of drawings and modeling, depending on your
requirements.

27. When building onto an existing structure this can be modeled in Advance Steel, but you must
remember to set that structure so that it is not used for the Drawings or BOMs. These settings
are on the Behavior tab in the object properties dialog. What this does is to set it so that when
the model is numbered, these existing components are numbered but with a negative value and
are not considered for drawings or material lists.
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